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1. OVERVIEW 
 
SUDAAN is a single program consisting of a family of procedures used to analyze data from complex 
surveys and other observational and experimental studies involving cluster-correlated data.  A complete 
description of the capabilities of SUDAAN can be found at http://www.rti.org/sudaan.   
 
The following document provides instructions on how to install and run SUDAAN. The most current 
version of these installation instructions can be obtained by visiting the SUDAAN website at 
http://www.rti.org/sudaan and selecting the Downloads tab. 
 

1.1 Technical Support 
 
RTI International (Research Triangle Institute) provides limited technical support for SUDAAN problems 
free of charge. The SUDAAN Language Manual provides detailed information on programming with 
SUDAAN and the SUDAAN Example Manual provides numerous examples. Both of these manuals can 
be installed during the SUDAAN setup (as PDF files). Hardcopy versions of these manuals can also be 
purchased from the SUDAAN website at http://www.rti.org/sudaan. You may also review bug reports, 
get answers to frequently asked questions and obtain other technical assistance through our website.  
 
For additional technical support please submit a support request available from our website or send an 
email to sudaan@rti.org. 
 
You may also contact the RTI SUDAAN offices at: 

 RTI International 
 SUDAAN Coordinator 
 3040 Cornwallis Road 
 Research Triangle Park, NC  27709-2194 
 
 Voice Mail: (919) 541-6602 
 FAX: (919) 541-7431 
 Email: sudaan@rti.org 
 
Due to the high volume of telephone calls we receive, you may be automatically sent to the SUDAAN 
voice mail when you call the SUDAAN office.  Please leave your name, telephone number and a brief 
description of the reason for your call.  One of our SUDAAN administrators will contact you as soon as 
possible. 
 
SUDAAN is supplied on a CD-ROM. This media contains all versions of SUDAAN compiled and tested 
for DOS and Windows. Note:  If you have licensed more than one version of SUDAAN you may 
install all licensed versions during one call to the SETUP.EXE.  
 

1.2 Previous Releases of SUDAAN 
 
We recommend that if you are installing SUDAAN Release 10 for the first time, and you have an existing 
license to SUDAAN Release 9, that you remove SUDAAN Release 9 from your computer before 
proceeding with the SUDAAN 10 installation.  This will avoid any conflicts that may arise when trying to 
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access SUDAAN.  To remove SUDAAN Release 9 from your system, you can: 
 
1. Insert the SUDAAN Release 9 CD, run the SETUP.EXE program and follow the instructions to 

remove SUDAAN from your computer. 
 
2. Select Add or Remove Programs from the Windows Control Panel.  
 
If you have a current license to a network version of SUDAAN (Standalone or SAS-Callable), we 
recommend both the administrator and each user remove SUDAAN Release 9 from their systems before 
proceeding with the SUDAAN 10 installation. 
 
Note:  If you are renewing an annual license to SUDAAN 10, and SUDAAN 10 already exists on your 
computer, then do not remove SUDAAN 10 before proceeding with the renewal process.  Section 1.6 
provides information on renewing annual SUDAAN licenses.   
 

1.3 Software Installation 
 
To install SUDAAN Release 10, insert the SUDAAN 10 CD into your CD-ROM drive and execute the 
program SETUP.EXE in the root directory on this disk. You can do this by entering: 
 

D:\setup 
 
From the Run… command on the Windows Start menu. Here we assume that D: is the drive letter 
associated with your CD-ROM reader. You can also execute SETUP.EXE by locating it in the Windows 
Explorer.  Double-click on the SETUP.EXE program icon to start the installation.  
 
The SETUP.EXE program will lead you through the installation process, during which you will do the 
following: 
 
1. Supply your name and company as they should appear in the SUDAAN banner. 
 
2. Read and accept the SUDAAN license agreement. 
 
3. Accept the default target directory C:\Program Files\SUDAAN\Release10 (recommended) or specify 

a different directory where SUDAAN should be installed.  
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4. As illustrated in Figure 1.1, you will be asked to check all versions of SUDAAN that you wish to 
install. Refer to subsequent sections of this Installation Guide for detailed instructions on installing 
each version.  Note that if you have purchased more than one license to SUDAAN (e.g. Standalone 
and SAS9-Callable Indiv. User), then all versions can be installed simultaneously by checking the 
corresponding boxes on this screen. 

 
 

Figure 1.1  Selecting Versions of SUDAAN During Installation 
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5. You will be asked to enter your 22-digit product key as illustrated in Figure 1.2.  A product key has 
been sent to you for each SUDAAN product you purchased.  The product keys are included in the 
letter correspondence that accompanied the SUDAAN SETUP disk. 

 
 

Figure 1.2  Enter Product Key 

 
 

 
IMPORTANT:  Be sure to save all product keys.  You will need them again whenever you have to 

reinstall the software, for example on a new computer.  
 
 
6. After you enter the SUDAAN product key for each SUDAAN product you purchased, SUDAAN will 

install all the necessary files in the directory you specified in Step #3. 
 
7. After a few more screens that are specific to the type of SUDAAN product you purchased (these are 

discussed in subsequent sections of this manual), you will see a message box as indicated in Figure 
1.3.  Although not required, we encourage all SUDAAN users to register their SUDAAN products. 
  At the SUDAAN product registration screen located at the SUDAAN website, you will be asked if 
you would like to receive any email correspondence regarding new releases, training and other 
significant SUDAAN-related news.  By checking this box, you will also automatically receive any 
news regarding SUDAAN-related bugs and appropriate work-arounds that have been identified by 
our staff.  Please note that we treat your email address as confidential information and we will not 
share this information with anyone outside the immediate SUDAAN team. 
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Figure 1.3  Product Regisration 

 
 

1.4 SUDAAN Help  
 
SUDAAN’s Interactive Help system is easily accessible from within SUDAAN by selecting Help from 
the Main Menu in Standalone versions of SUDAAN, or by selecting Help from the Main Menu from the 
SAS Windows interface in SAS-callable versions of SUDAAN.  SUDAAN’s Interactive Help can also be 
accessed from the SUDAAN folder on the Start Programs menu in Windows.  
 
The SUDAAN Interactive Help is also available at SUDAAN’s website: http://www.rti.org/sudaan.  
Click on Technical Assistance, then On-line Help.  
 

1.5 SUDAAN Manual 
 
The SUDAAN Language Manual and SUDAAN Example Manual will be installed by default in the 
Manual subdirectory of SUDAAN\Release10 and shortcuts to these documents will be located in the 
SUDAAN folder on the Start Programs menu in Windows. These manuals are in PDF format. Use 
Adobe Acrobat Reader, which is available free from Adobe’s website to view these documents. You can 
find additional SUDAAN examples on our website. 

1.6 Procedure to Renew a SUDAAN License 
 
Unless you have obtained a permanent license to this release of SUDAAN, you will need to renew your 
SUDAAN license in order to continue using the software after the expiration date. Once you have 
purchased the renewal, you will receive a new 22-digit Product Key for each version of SUDAAN that 
you have an annual license to. To update your software, do the following for each version of SUDAAN 
you are renewing: 
 
1. IMPORTANT:  The SUDAAN renewal software requires that .NET Framework Version 2.0 or 

higher from Microsoft be installed on your machine.  This can be installed, free-of-charge, from 
www.microsoft.com/downloads.  Most machines will have this installed already.  We recommend 
attempting to renew your software first.  If you receive an error message that references the .NET 
Framework, then download the necessary files from Microsoft. 

 
2. For Windows XP or 2000, make sure that you are logged into your computer with administrator 

privileges. 
 
3. Click on the Renew SUDAAN item in the SUDAAN folder on the Start Programs menu in 

Windows.  
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4. Enter your name and company as they should appear in the SUDAAN banner, and your new 22-digit 
product key. 

 
5. The renewal software will attempt to find the most current version of your SUDAAN.EXP file that is 

consistent with the 22-digit product key you entered in the previous step.  Hit “OK” at the message 
box displayed in Figure 1.4. 

 
Figure 1.4  SUDAAN Will Search For Appropriate SUDAAN.EXP 

 
 
6. The renewal software will ask you to select your SUDAAN.EXP file.  By default, this will be located 

under 
 

 Directory Location of SUDAAN.EXP SUDAAN Version
 Program Files\SUDAAN\Release10\DOS For DOS Version 
 Program Files\SUDAAN\Release10\WinInd For Standlone Individual User Version 
 Program Files\SUDAAN\Release10\WinNet For Standalone LAN User Version 
 Program Files\SUDAAN\Release10\SAS9Ind For SAS9 Callable Individual User Version 
 Program Files\SUDAAN\Release10\SAS9Net For SAS9 Callable LAN User Version 

 
Figure 1.5 illustrates the box that will appear when the renewal software asks for the 
SUDAAN.EXP file.  After you have identified the correct file, simply select the file and hit 
the “Open” button 

 
Figure 1.5  Selecting the SUDAAN.EXP File During the SUDAAN Renewal Process 
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7. The software will ask you to verify the information about your license in the screen depicted in 

Figure 1.6.  If this information is correct, hit the “Yes” button. 
 

Figure 1.6  Verifying Renewal Information 

 
 
 At this point your software is updated, and you can continue to use it. 
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2. INSTALLATION INSTRUCTIONS FOR DOS STANDALONE, 
INDIVIDUAL USER VERSION 

 

2.1 System Requirements 
 
Category Requirement
Resources 8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 2000 or Windows XP  
 

2.2 Software Installation 
 
During the installation process, select DOS by clicking the appropriate check box to the left of this item 
in the left pane of the setup window when you reach the screen displayed in Figure 1.1. 
 
By default, the following components will be installed.  However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in the 
right pane of the setup window. 

 
Component  Description 
Program Files   Files required to execute SUDAAN procedures 
Language Manual SUDAAN Language Manual in Adobe Acrobat PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat PDF format 
 

 
Following installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
 

• SUDAAN\Release10  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files. 

 
• SUDAAN\Release10\DOS  

This subdirectory will contain all program and other required files. 

   
• SUDAAN\Release10\Help 

This subdirectory will always be present, and contains the CHM Help. Note that SETUP will 
create a shortcut to it in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release10\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual, 
and/or the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents 
in the SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN website, SUDAAN Language and Example Manuals, SUDAAN Help, and the SUDAAN 
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Renewal program. 
 

2.3 Running SUDAAN  
 
After installation, you will need to add your new SUDAAN directory, by default  
 
 <path>\SUDAAN\Release10\DOS,  
 
to your directory PATH.  <path> is the complete path specification for the SUDAAN programs, which by 
default is “C:\Program Files”.  Remove any old SUDAAN directory from the PATH.  If you make these 
changes in your system settings, they will be available each time you boot your system. 
 
The syntax for executing SUDAAN (from the DOS Command prompt, or from the RUN command) is: 
 
 SUDPROC infile [outfile] [-r | -a] 
 
Where infile is the name of the file containing SUDAAN procedure statements, outfile is the name of the 
file to which SUDAAN should direct outputs, and r and a are write options. 
 
IF outfile already exists... 
 

 -r causes the file to be overwritten, and 
 -a causes the output to be appended to the existing file 

 
IF you omit outfile... 
 

 SUDAAN directs all output to the screen. 
 
See the SUDAAN Language Manual and the SUDAAN Example Manual for complete information on 
using the SUDAAN procedures. 
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3. INSTALLATION INSTRUCTIONS FOR WINDOWS 
STANDALONE INDIVIDUAL USER VERSION   

 

3.1 System Requirements 
 
Category Requirement
Resources 8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 2000 or Windows XP  
 

3.2 Software Installation 
 
During the installation process, select Standalone Indiv. User by clicking the appropriate check box to 
the left of this item in the left pane of the setup window when you reach the screen displayed in Figure 
1.1. 
 
By default, the following components will be installed. However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in the 
right pane of the setup window. 
 

Component Description 
Program Files  Files required to execute SUDAAN procedures 
HTML Help This is the HTML Help version of the Interactive SUDAAN Help system 
CHM Help This is the CHM (Compiled) Help version of the Interactive SUDAAN 

Help system.  Note that the screens and material in the HTML and CHM 
Help are identical.  This component must be installed if you wish to 
access SUDAAN’s Interactive Help from within the SUDAAN 
Standalone interface. 

Language Manual SUDAAN Language Manual in Adobe Acrobat PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat PDF format 

 
• SUDAAN\Release10  

This subdirectory will contain SUDAAN’s license renewal software and README.1ST files. 
 

• SUDAAN\Release10\WinInd  
This subdirectory will contain all program and other required files.  

 
• SUDAAN\Release10\Help 

This subdirectory will always be present, and contains the HTML and/or CHM Help. Note that 
SETUP will create a shortcut to these in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release10\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual, 
and/or the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents 
in the SUDAAN folder on the Start Programs Menu. 
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The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN program, the SUDAAN website, SUDAAN Language and Example Manuals, SUDAAN Help, 
and the SUDAAN Renewal program. 
 

3.3 Running SUDAAN  
 
Please refer to Chapter 5 of this manual for complete details on how to run Windows Standalone 
SUDAAN.  
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4. INSTALLATION INSTRUCTIONS FOR WINDOWS 
STANDALONE NETWORK  

 
All LAN versions of SUDAAN should be installed using a two-step process: 
 
 1. Install the Administrator version of SUDAAN from the CD as described in Section 4.2. 
 
 2. Each user wishing to use SUDAAN on the LAN must complete the LAN User Version 

installation as described in Section 4.3.  All files needed for the LAN User Version installation 
will be installed during the LAN Administrator Version installation.   

 
IMPORTANT: As indicated in the SUDAAN license agreement, the maximum number of 

simultaneous users who access SUDAAN on the network should not exceed the total 
number of users associated with your SUDAAN LAN license. 

 

4.1 System Requirements 
 
Category Requirement
Resources 8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 2000 or Windows XP  
 

4.2 Software Installation–LAN Administrator 
 
During the installation process, select Standalone Network by clicking the appropriate check box to the 
left of this item in the left pane of the setup window when you reach the screen displayed in Figure 1.1. 
 
By default, the following components will be installed. However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in the 
right pane of the setup window. 
 

Component Description 
Program Files  Files required to execute SUDAAN procedures 
NetUser Setup Files SETUP.EXE and other files for network user install (See Section 4.3) 
HTML Help This is the HTML Help version of the Interactive SUDAAN Help system 
CHM Help This is the CHM (Compiled) Help version of the Interactive SUDAAN 

Help system.  Note that the screens and material in the HTML and CHM 
Help are identical.  This component must be installed if you wish to 
access SUDAAN’s Interactive Help from within the SUDAAN 
Standalone interface. 

Language Manual SUDAAN Language Manual in Adobe Acrobat PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat PDF format 

 
Following installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
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• SUDAAN\Release10  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files.  

  
• SUDAAN\Release10\WinNet 

This subdirectory will contain all program and other required files. 
 

• SUDAAN\Release10\WinNet\NetUser 
This subdirectory will contain SETUP.EXE and other files required for the network user install 

 
• SUDAAN\Release10\Help 

This subdirectory will always be present, and contains the HTML and/or CHM Help. Note that 
SETUP will create a shortcut to these in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release10\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual, 
and/or the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents 
in the SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN program, the SUDAAN website, SUDAAN Language and Example Manuals, SUDAAN Help, 
and the SUDAAN Renewal program. 
 

4.3 Software Installation–LAN User 
 
The SETUP.EXE program in the NetUser subdirectory of the SUDAAN\Release10\WinNet network 
directory is a program that will automatically set up SUDAAN for each user. This program should be run 
by each user.  After SETUP has run, verify that SETUP has created a SUDAAN folder in the Start 
Programs menu. In the folder one should find shortcuts to the SUDAAN program, the SUDAAN 
website, SUDAAN Language and Example Manuals and the SUDAAN Help.  
 

4.4 Running SUDAAN  
 
Please refer to Chapter 5 of this manual for complete details on how to run Windows Standalone 
SUDAAN.  
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5. SUDAAN WINDOWS USERS GUIDE 
 
This chapter will introduce you to the special features of the Standalone Windows Version of SUDAAN 
(Individual or LAN version). You can execute this version in either interactive or batch mode. Section 5.1 
describes the SUDAAN interface available to you when you run in interactive mode. Section 5.2 
describes how to use SUDAAN in batch mode. 
 

Figure 5.1: SUDAAN for  
Windows Icon 5.1 Using Interactive SUDAAN 

 
To launch an interactive session of SUDAAN for Windows, 
click on the Start button on your Windows Desktop 
(generally in the lower left corner), choose Programs or All 
Programs, and then click on the SUDAAN icon. You may 
also locate the SUDAAN executable, WSUDAAN.EXE in 
the Windows Explorer and double click on the icon to 
execute SUDAAN as shown in Figure 5.1. 
 
5.1.1 Main Menu 
 
SUDAAN’s interface (Figure 5.2) displays two windows: the Input window and the Output window. The 
Input window is a text editor in which you can create or edit SUDAAN programs; the Output window is a 
read-only viewer used to display the results 
from SUDAAN runs. You can switch from the 
Input window to the Output window by simply 
clicking in the Output window area, and vice 
versa. 

Figure 5.2: SUDAAN Input and Output Windows 

 

 
The SUDAAN interface has a single main 
menu bar at the top of the screen for both Input 
and Output windows as shown in Figure 5.2. 
From this menu, you can edit and save your 
SUDAAN programs, execute, display and save 
SUDAAN results, access font selection and 
data directories options, and get online help 
resources. These options are discussed in the 
next several sections. 
 
5.1.2 File Menu Option 
 
From the Input window, you can open an existing SUDAAN program by selecting Open from the File 
menu, or you can select New to create a new program from scratch. Note that the capacity of the Input 
window is 2GB under Windows 2000 and XP. 
 
From either window you can choose Save or Save as to save the contents of the window and you can 
choose Print to print the contents of the window.  
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Figure 5.3 and Figure 5.4 illustrate the Open and Save screens in SUDAAN. 
 

Figure 5.3: File Popup Menu for  
Input Window 

 

Figure 5.4: File Popup Menu for 
Output Window 

 
 

 
5.1.3 Edit Menu Option 
 
The Edit option from the menu bar provides the standard Undo, Cut, Copy, Paste and Select All 
functions for the Input window. You can select these functions using either the mouse or the key 
accelerators.  Selecting Clear from the Edit menu 
will clear everything in the Input window; anything 
unsaved will be lost. 

Figure 5.5: Edit Popup Menu from  
Input Window 

 
The only available selection in the Edit Menu for the 
Output window is Clear, since it is a read-only 
viewer.  You can save the output to a file and then 
edit it using another editor, for example, NotePad. 
 
Figure 5.5 illustrates the Edit screen in SUDAAN 
associated with the Input window. 
 
 
5.1.4 Option Menu Option 
 
Selecting Option from the menu bar will allow you 
to change the default directory and change the font 
for both viewing and printing. This is depicted in 
Figure 5.6. 
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Figure 5.6: Option Popup Menu 

 
 

 

Figure 5.7: Data Dir... Option Dialog Box 

 
 
 
 
 
 
 
 
 
 

 
 
 
You can set the Data Directory for your SUDAAN data files by selecting DataDir... from the Option 
menu.  After selection, a dialog box will appear as depicted in Figure 5.7. 
 
NOTE:  If you don’t specify a full path name in the DATA= option on the PROC statement of your 
SUDAAN program or in the FILENAME= option on the PRINT and OUTPUT statements, SUDAAN 
will assume the data is in the directory specified in DataDir... on the Option menu. The default Data 
Directory is the directory where the SUDAAN program is located.  
 
Once you set this directory, SUDAAN saves it in a SUDAAN.INI file for future use. SUDAAN will 
continue to use this Data Directory for both interactive and batch mode until you change it. The 
SUDAAN.INI file in your Windows directory has several sections. You should not attempt to modify this 
file. The sections entitled [DATA DIRECTORY] and [FILE DIRECTORY] in SUDAAN.INI are used to 
store the currently selected values for these directories. DataDir= and FileDir= are reserved case 
sensitive keywords in SUDAAN.INI which you should never change. DataDir is used to keep track of 
your Data Directory settings. You should change the Data Directory setting only by choosing the 
DataDir... option from the Option menu. FileDir is used to initialize the current working directory for 
SUDAAN and should never be changed. 
 
The Font… option is available from both Input and Output windows. Select Font from the Option Menu 
to specify the font type and font size for both viewing and printing. You can select different fonts for the 
Input and Output windows. The Courier or Courier New font is suggested for the Output window, since it 
is a monospaced font. 
 
5.1.5 Execute Command 
 
Click Execute! on the menu bar or press the F3 key, to execute the program in the Input window. The 
results are displayed in the Output window. Use the cursor keys to navigate within the Output window.  
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Please note the following: 
 
■ If you don’t clear the Output window following execution, the results from subsequent runs will be 

appended to it.  
 
■ SUDAAN saves all output from the current program in the file SUDAAN.OUT in the WSUDTEMP 

directory created in your local TEMP directory (by default, your local TEMP directory is located at 
C:\Documents and Settings\<user>\Local Settings\Temp\WSUDTEMP). In cases where no output 
appears in your Output window because of an error, check this file to determine the possible cause of 
problems. 

 
5.1.6 Window Menu Option 
 
The Window menu option (Figure 5.8) provides utilities for Cascade, Tile Horizontal and Tile 
Vertical. The active window (either Input or Output) is checked. You can switch from Input window to 
Output window by selecting Output from the Window menu, and vice versa. 
 
5.1.7 Help Menu Option 
 
If you installed the CHM Help during setup, Help on the menu bar links to a complete online reference 
for all SUDAAN features and utilities. The Help menu has the following options (see Figure 5.9): 
 
■ Contents:  (F1) links to the Help facility with Contents displayed in the left pane. SUDAAN Help is 

a compiled HTML (.CHM) file which can be accessed either from the Help menu on SUDAAN’s 
main menu, or directly from the Windows Explorer.  

 
■ Search for help on..:  Links to the Help facility with the Keyword Search dialog displayed in the left 

pane. 

 

Figure 5.9: Help Popup Menu Figure 5.8: Window Popup Menu 
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■ Index: Links to the Help facility with the index tab displayed in the left pane. 
 
■ About SUDAAN For Windows: Displays the SUDAAN release number as well as your license 

information. 
 
 
5.1.8 The Right Mouse Button Options 
 
Click the right mouse button in either the input or output window and then select different options using 
the left mouse button. The options are a subset of those on the SUDAAN main menu. See Figure 5.10 
and Figure 5.11 for an example. 
 

Figure 5.10: Right Mouse Menu 
from Input Window 

 
 

Figure 5.11: Right Mouse Menu 
from Output Window 

 

5.2 How to Execute SUDAAN in Batch Mode 
 
The complete command line syntax to run SUDAAN in batch mode is: 
 

<path>WSUDAAN.EXE [infile] [outfile] [-r | -a] 
 
where: 
 
 path is the complete path specification for the SUDAAN executable 
 
 infile is the complete file specification for the file containing your SUDAAN program. If this 

option is omitted, an interactive session of SUDAAN is launched 
 
 outfile is the name of the file where output should be directed. If this option is omitted, SUDAAN 

will direct output to a file with the same directory location and name as infile, but with extension 
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“.OUT”. If the outfile already exists, and no write option is specified, SUDAAN will display a 
dialog box to confirm that you want to overwrite the existing file. 

 
 -r | -a is the write option. The option r indicates that SUDAAN should replace or overwrite an 

existing file of the same name in the same location. The option a indicates that SUDAAN should 
append new output to an existing file of the same name in the same location. 

 
If you don’t specify the full path name of the input data file using the DATA= option on the SUDAAN 
procedure statement, SUDAAN will assume the data is in the DataDir= variable of the [DATA 
DIRECTORY] section of the SUDAAN.INI file. If the data is not in the specified directory, there will be 
an error message in the SUDAAN output file. When the SUDAAN batch job starts to run, the following 
message box will appear (Figure 5.12) then automatically disappear when the job is completed. 
 

Figure 5.12: SUDAAN Job is Running Message 

 
 
 
SUDAAN can be run in batch mode using the following methods: 
 
1. Choose Run from the Start menu in Windows and type in the desired WSUDAAN.EXE 

command line. 
 
2. Select Command Prompt from the Start menu in Windows (sometimes located under All 

Programs and then Accessories) and type in the desired WSUDAAN.EXE command line. 
 
3. The WSUDAAN.EXE command line can be put in a typical .BAT file and executed accordingly. 
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6. INSTALLATION INSTRUCTIONS FOR SAS-CALLABLE 
INDIVIDUAL USER VERSION  

 

6.1 System Requirements 
 
Category Requirement
Resources 8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 2000 or Windows XP 
Software  SAS® 9 for Windows 
 

6.2 Software Installation 
 
During the installation process, select SAS9-Callable Indiv. User by clicking the appropriate check box 
to the left of this item in the left pane of the setup window when you reach the screen displayed in Figure 
1.1. 
 
By default, the following components will be installed.  However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in the 
right pane of the setup window. 
 

Component  Description 
Program Files   Files required to execute SUDAAN procedures 
HTML Help Files SUDAAN online help, callable from SAS 
CHM Help File Compiled Help file.  Note that the screens and material in the HTML and 

CHM Help are identical.  
Language Manual SUDAAN Language Manual in Adobe Acrobat PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat PDF format 

 
 
During the installation process, you will be asked to supply the directory location of your default SAS 
configuration file (SASV9.CFG). SETUP will display the correct path for you if SAS is installed in the 
default locations. If you are not sure where the SASV9.CFG is, or you want to override the default 
location, you can use the Browse option provided by SETUP, or you can search for the file in the 
Windows Explorer. If SETUP locates the file, it creates a backup copy, named SASV9.BK# before 
making changes in the SASV9.CFG file. SETUP makes the following changes to the file: 
 

• If you have specified installation of HTML Help files, then SETUP inserts the following line 
at the beginning of the SASV9.CFG file. By default: 

 
-HELPREGISTER 'SUDAAN Help' 'C:\Program Files\SUDAAN\Release10\HELP\sudaan.htm' 

 
• SETUP inserts a line within the –PATH command at the end of the SASV9.CFG file pointing 

to the location of your SUDAAN program files. By default: 
 

 ‘C:\Program Files\SUDAAN\Release10\SAS9Ind’ 
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Note:  If the default SASV9.CFG contains only a –CONFIG command pointing to a complete 
SASV9.CFG file in another location, the install will update the second SASV9.CFG file. 
 
IMPORTANT: SAS will not be able to find your SUDAAN.DLL and HTML Help files without these 

changes to your SASV9.CFG.  If you have multiple SASV9.CFG files on your 
computer (both local and network drives), check to make sure that you have specified 
the default SAS configuration file within SETUP and that you manually update the 
remaining SASV9.CFG files you will be using with SUDAAN. 

 
Following a default installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
 

• SUDAAN\Release10  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files. 

 
• SUDAAN\Release10\SAS9Ind  

This subdirectory will contain all program and other required files. 
 

• SUDAAN\Release10\Help 
This subdirectory will be present if you specify installation of either HTML or CHM Help during 
the installation process. Note that if you specify installation of CHM Help, then SETUP will 
create a shortcut to it in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release10\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual or 
the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents in the 
SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN website, SUDAAN Language and Example Manuals, SUDAAN Help, and the SUDAAN 
Renewal program. 
 

6.3 Running SUDAAN  
 
You can run SUDAAN jobs in either SAS’s interactive mode or in batch mode. Execute SUDAAN 
procedures just like any other SAS procedures in either mode. NOTE: Some SUDAAN syntax has been 
changed for this SAS-Callable version. Please refer to the SUDAAN Language Manual for details. See 
the SAS User’s Manual for information on how to run SAS jobs.  
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7. INSTALLATION INSTRUCTIONS FOR SAS-CALLABLE 
NETWORK 

 
All SAS-Callable, LAN versions of SUDAAN should be installed using a two-step process: 
 
 1. Install the Administrator version of SUDAAN SAS9-Callable from the CD as described in 

Section 7.2. 
 
 2. Each user wishing to use SUDAAN on the LAN must complete the LAN User Version 

installation as described in Section 7.3.  All files needed for the LAN User Version installation 
will be installed during the LAN Administrator Version installation. 

 
IMPORTANT: As indicated in the SUDAAN license agreement, the maximum number of 

simultaneous users who access SUDAAN on the network should not exceed the total 
number of users associated with your SUDAAN LAN license. 

 

7.1 System Requirements 
 
Category  Requirement
Resources  8 MB of RAM (16 MB RAM suggested), 40 MB of hard disk  
Operating System Microsoft Windows 2000 or Windows XP  
Software  SAS® 9 for Windows 
 

7.2 Software Installation–LAN Administrator 
 
During the installation process, select SAS9-Callable Network by clicking the appropriate check box to 
the left of this item in the left pane of the setup window when you reach the screen displayed in Figure 
1.1. 
 
By default, the following components will be installed.  However you can deselect any of these 
components by clicking on the check boxes to the left of the component names which are displayed in the 
right pane of the setup window. 

 
Component Description 
Program Files  Files required to execute SUDAAN procedures 
HTML Help Files SUDAAN online help, callable from SAS 
CHM Help File Compiled Help file.  Note that the screens and material in the HTML and 

CHM Help are identical. 
NetUser Setup Files SETUP.EXE and other files for network user install.  (See Section 7.3)  
Language Manual SUDAAN Language Manual in Adobe Acrobat PDF format 
Example Manual SUDAAN Example Manual in Adobe Acrobat PDF format 

 
During the installation process, you will be asked to supply the directory location of your default SAS 
configuration file (SASV9.CFG). SETUP will display the correct path for you if SAS is installed in the 
default location. If you are not sure where the file is, or you want to override the default location, you can 
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use the Browse option provided by SETUP, or you can search for the file in the Windows Explorer. If 
SETUP locates the file, it creates a backup copy, named SASV9.BK# before making changes in the 
SASV9.CFG file. SETUP makes the following changes to the file: 
 

• If you have specified installation of HTML Help files, then SETUP inserts the following line 
at the beginning of the SASV9.CFG file. By default: 

 
-HELPREGISTER 'SUDAAN Help' 'C:\Program Files\SUDAAN\Release10\HELP\sudaan.htm'  

 
• SETUP inserts a line within the –PATH command at the end of the SASV9.CFG file pointing 

to the location of your SUDAAN program files. By default: 
 
 ‘C:\Program Files\SUDAAN\Release10\SAS9Net’ 
 
If the default SASV9.CFG contains only a –CONFIG command pointing to a complete SASV9.CFG file 
in another location, the install will update the second SASV9.CFG file. 
 
IMPORTANT: SAS will not be able to find your SUDAAN .DLL and HTML Help files without these 

changes to your SASV9.CFG. If you have multiple SASV9.CFG files on your 
computer (both local and network drives), check to make sure that you have specified 
the default SAS configuration file within SETUP and that you manually update the 
remaining SASV9.CFG files you will be using with SUDAAN. 

 
Following a default installation, the following subdirectories and files should be present (by default under 
C:\Program Files, or in the installation directory you have specified during setup) 
 

• SUDAAN\Release10  
This subdirectory will contain SUDAAN’s license renewal software and README.1ST files. 

 
• SUDAAN\Release10\SAS9Net 

This subdirectory will contain all program and other required files. 
 

• SUDAAN\Release10\SAS9Net\NetUser 
This subdirectory will contain the SETUP for all network users. 

 
• SUDAAN\Release10\Help 

This subdirectory will be present if you specify installation of either HTML or CHM Help during 
the installation process. Note that if you specify installation of CHM Help, then SETUP will 
create a shortcut to it in the SUDAAN folder on the Start Programs Menu. 

 
• SUDAAN\Release10\Manual 

This subdirectory will be present if you specify installation of the SUDAAN Language Manual or 
the SUDAAN Example Manual. Note that SETUP will create shortcuts to these documents in the 
SUDAAN folder on the Start Programs Menu. 

 
The SETUP program will install a SUDAAN folder on the Start Programs menu with shortcuts to the 
SUDAAN website, SUDAAN Language and Example Manuals, SUDAAN Help, and the SUDAAN 
Renewal program. 
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7.3 Software Installation–LAN User 
 
The SETUP.EXE program in the NetUser subdirectory of the SUDAAN\Release10\SAS9Net network 
directory is a program that will automatically setup SUDAAN for each user.  This program should be run 
by each user.  After SETUP has been run for each user, verify that the following steps have completed 
successfully.  
 
1. The SASV9.CFG file – Verify Help 

In order to use the SUDAAN interactive help system, the following line must appear at the beginning 
of the default SASV9.CFG file. (for example): 

 
-HELPREGISTER 'SUDAAN Help' 'M:SUDAAN\Release10\Help\SUDAANHelp.HTML'  

 
where in this example the directory where SUDAAN files are located is M:\SUDAAN\Release10. 
If your network administrator has installed the HTML help files, then verify the presence of this line. 
 

2. The SASV9.CFG file – Verify SUDAAN Path 
Also verify that the network path to SUDAAN is inserted into the –PATH command in the default 
SASV9.CFG file. This tells SAS where to find SUDAAN procedures. For example, if SUDAAN is 
installed at M:\SUDAAN\Release10\SAS9Net, then the following line should be present: 

 
M:\SUDAAN\Release10\SAS9Net 

 
in the –PATH command. This command is usually located at the end of the SASV9.CFG file. 

 
Note: If the default SASV9.CFG contains only a –CONFIG command pointing to a complete 
SASV9.CFG file in another location, the install will update the second SASV9.CFG file. 

 
If a user changes their network drive letter associated with SUDAAN, or if the directory where SUDAAN 
is located changes, then the user will need to make the corresponding changes in their SASV9.CFG file. 
 

7.4 Running SUDAAN  
 
SUDAAN jobs can be run in either SAS’s interactive mode or in batch mode.  Execute SUDAAN 
procedures just like any other SAS procedures in either mode. NOTE: Some SUDAAN syntax has been 
changed for this SAS-Callable version. Please refer to the SUDAAN Language Manual for details. See 
the SAS User’s Manual for information on how to run SAS jobs.  
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